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Copyright and Licensing Information 

Impact/SQL Version 10.3.0  

Copyright © 1992-2015 by USA Digital Solutions, Inc., Phoenix, Arizona. 

No part of this publication may be reproduced in any form without prior written permission of USA Digital 

Solutions, Inc.  For additional information, contact USA Digital Solutions, Inc., 10835 N. 25
th
 Ave., 

Phoenix, AZ 85029, or call 602-866-8199 x 2. 

Microsoft, Windows, Office, Word, Excel, and MS-DOS are registered trademarks of Microsoft 

Corporation in the United States and/or other countries.  Crystal Reports is a registered trademark of SAP 

AG.  RealEC Technologies, Inc. is a division of Black Knight Financial Services.  All other brand and 

product names are trademarks or registered trademarks of their respective companies. 

IMPORTANT NOTICE – READ CAREFULLY 

Use of this software and related materials is provided under the terms of the Impact/SQL License and 

Support Agreement.  By accepting the License, you acknowledge that the materials and programs 

furnished are the exclusive property of USA Digital Solutions, Inc.  You do not become the owner of the 

program, but have the right to use it only as outlined in the Impact/SQL License and Support Agreement. 

All USA Digital Solutions, Inc. products are designed to ASSIST in maintaining data and/or 

producing documents and reports based upon information provided by the user and logic, rules, 

and principles that are incorporated within the program(s).  Accordingly, the documents and/or 

reports produced may or may not be valid, adequate, or sufficient under various circumstances 

at the time of production.  UNDER NO CIRCUMSTANCES SHOULD ANY DOCUMENTS 

AND/OR REPORTS PRODUCED BE USED FOR ANY PURPOSE UNTIL THEY HAVE BEEN 

REVIEWED FOR VALIDITY, ADEQUACY AND SUFFICIENCY, AND REVISED WHERE 

APPROPRIATE, BY A COMPETENT PROFESSIONAL.  
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Introduction to Impact/SQL MIS 

This manual explains all of the functionality contained within the Impact/SQL Management Information 

(MIS) module, and discusses how each is used.  As each company functions in its own unique way, there 

are some functions that may not be utilized, but you are encouraged to examine and consider all of them, 

to ensure you are getting the most out of Impact. 

The MIS module is generally utilized by the Accounting Department and Company management to 

generate reports used to analyze operational activity and results – based on data in Impact/SQL.   

The MIS reports (and other reports in Impact’s other modules) are based on Crystal Reports ® templates.  

Prior to version 8.0 of Impact/SQL, Crystal Reports 8.5 ® was used to develop reports.  With Impact/SQL 

version 8.0, Crystal Reports 2008 ® was introduced.  Once a company ceases to use versions of Impact 

below 8.0, they can use Crystal Reports 2008 ® to prepare custom MIS report templates for use in the 

MIS module.   
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General Information and Helpful Hints 

Some formatting conventions used in this manual are: 

When you need to press the Tab key, you will see TAB in this manual. 

When you see text displayed on a menu or window such as the words “OK” or “Cancel”, you will 

see OK or Cancel in this manual. 

Custom Reports > Print Reports would mean that you select Custom Reports from the main 

menu and then select Print Reports from the sub menu. 

Quick Keys 

In the Impact/SQL modules there are opportunities to move through the options available without using 

the mouse. Most menu items contain an underlined letter. If you hold down the ALT key and press the 

underlined letter of the option list you want displayed, the menu will drop down.   

ALT+C will open the Custom Reports drop-down menu list, in the MIS module; and, 

ALT+C+P will open the Print Reports item on the Custom Reports menu. 

Info Icons 

The  Info icons are found in various screens throughout Impact/SQL. When you click an Info icon 

next to a field, a non-editable pop-up box is displayed, providing additional information about the field.  

Closing Impact/SQL  

As with most Windows applications, you can close Impact/SQL modules by clicking  in the upper-

right hand corner of the desktop.  

Dates 

For dates in the current year, enter the two-digit month and two-digit day; for example, “0625” for June 25, 

2015 (in 2015). Do not enter hyphens or slashes when entering dates into Impact. If the date is not within 

the current year, but in the current century, enter the date as two-digit month, two-digit day and two digit 

year, for example: “062514” for June 25, 2014.  If entering a different century other than the current 

century, you must enter a four-digit year.   

You can also click the  Calendar icon, just to the right of the date 

entry area, or press the CTRL+D Quick Key to display the Calendar 

tool.  Select the desired date from the calendar presented. 
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Previewing Reports 

In Impact/SQL, reports can be previewed on screen,  prior to, or in lieu of, printing or emailing them.  

Select the Preview button, from the printer control screen, to view the report on screen.  At the top of the 

Report Viewer window there are a series of icons that can be used to work with the report on the screen. 

 

 

 

 Export – this icon will initiate the Crystal Reports ® export function through which the report or the 

report’s data can be exported to an electronic file, of several types, and to a location of the user’s choice.  

Most typically, a PDF export of the report is done. 

 

 Print – this icon is used to print the report from the Report Viewer screen. 

 

 Display Grouping – this icon will present a grouping tree on the left side of the screen that can be 

used to move through the report more quickly. 

 

     These icons will take the user to the first page, the previous page, the next page and the 

last page, respectively. 

 

 Go to Page – this icon, when clicked will prompt the user for a specific page number to go to. 

 

 Search – this icon is used to initiate a search for a specific section of text or a value. 

 

 Zoom – this icon is used to zoom in or out on a report. 
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Logon 

Access to the Impact/SQL MIS module (as to all Impact modules), is controlled by a user-rights table, 

administered by a limited set of user ID’s that have sufficient authority granted to them.  This is a very 

important control, and should be carefully managed.  Depending on the nature of the rights assigned to a 

user, they will have access to various pieces of the overall Impact suite, but generally not complete 

access.  This functionality helps reinforce audit controls, and needs to be considered in conjunction with 

the network security plan. 

The system can be configured to require a logon routine, each time the user opens an Impact module, or 

it can be configured to provide for an automatic logon utilizing the NT user name.  By providing for an 

automatic logon utilizing the NT user name, control over the access to the application is very flexible: both 

the system administrator and the rights table within Impact can control access.  The system administrator 

can control access by disabling the user’s NT user name, a likely event in the case of an employee’s 

departure. In addition, the user name can be disabled within Impact Utilities – which will only affect the 

user’s ability to access Impact modules.  This would be done if the user is still using the rest of the 

network, but should no longer be accessing Impact. 

There is not an automatic expiration of passwords setting within Impact, so to ensure strong controls the 

administrator would have to routinely change all users’ Impact passwords, and inform the users of them, if 

the automatic logon based on NT user names is disabled.  For this reason, the use of an automatic logon 

based on NT user names can be a more effective control – assuming automatic expiration of passwords 

is implemented through the NT operating system.  This matter is more fully explained in the Impact 

Utilities manual. 

If the system is configured for NT Authentication, and more than one database is available, a screen like 

that shown below will be presented, after the user double-clicks on the Impact/SQL MIS  icon on their 

desktop.  The appropriate database should be selected and OK clicked on.  If only one database is 

available, the user, if they have permission, will be taken directly into the module. 

 

 

 

 

 

 

 

 

  

Drop down list arrow 
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When configured to require a logon step, the user will be identified within the Impact system by their 

initials (3 maximum), and will be given a password.  A login screen will be presented asking for the user’s 

initials and password. 

Enter the user initials in the first field, and then TAB to the Password field. Enter the password and, if the 

correct database is identified in the Log on to: field, click OK. If the database is not correct, then TAB to 

the Log on to: field and select the correct database by clicking on the drop down list arrow and 

highlighting a database name; then click OK. Most users will only have one database available. 

Alternatively, if the user does not want to use the mouse to click OK, they can hit the TAB key until OK is 

highlighted, and hit ENTER. 

 

NOTE: When they enter their password, it will not display on the screen, but will be represented 

by a series of asterisks “****”. 

 

If the user does not want to continue, they should click on Cancel instead. This will cause the Logon 

dialogue box to close and the Impact/SQL MIS module will not be opened. 

KEEP PASSWORDS PRIVATE. Users should not share their passwords or log on to the system and 

then let someone else operate under their session. The initials of the user logged on to the system will 

attach to transactions entered, and users will only want to be responsible for their own activity. 

If users forget their password, the administrator of the Impact application must assign a new one. 
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Impact/SQL Management Information (MIS) Desktop 

Impact will display a desktop as shown below when you sign into the MIS module. 

The screen, as it initially opens, presents the user with a menu of options across the top of the screen.  

Each option has a dropdown menu below it, which will be displayed when you click on the option name.  

Once you have clicked on one option name, and the menu list below it is presented, you can slide your 

cursor down the list, with your mouse, to get to the function you wish to use.  If you are not sure under 

which option heading the desired function is housed, click on any option heading and, once the menu list 

is presented, slide your mouse to the left or right, to other option headings, and their menu lists will 

present without you having to click again, and you can then browse all of the menu choices available to 

you. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The current date should be displayed in the lower right corner of the Impact/SQL desktops. If you do not 

have the current date displayed, notify your system administrator and do NOT continue to enter activity 

into the system – having the correct dates on activity is very important. The current date is used for the 

print date on documents, the receipt date, check date, and voiding of check date, for example. 

Exit 

You should exit out of Impact when you are leaving your desk for an extended period, or are going home 

for the day. Use the  Close icon, in the upper right corner of the Impact desktop window, to exit.  

Always exit out of Impact at the end of each day, before logging off of your computer. If you leave your 

Impact MIS session logged on, others will have access to your “rights”, and this could raise security 

concerns.  The menu path to exiting is File > Exit.  That is the sole option under the File menu.  

Current date Logged in user’s name 
 

The Impact MIS desktop may 
show your company logo 
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Impact Widget Dashboard 

Impact Widgets were introduced in Impact/SQL version 8.0.  The MIS module currently has one widget: 

Report Schedules. This widget will present scheduled reports.  The scheduling of reports is discussed in 

the next few pages.  The controls for widgets in this and the other Impact modules are described below. 

 

At the bottom of the Impact MIS desktop window there is a dark band, labeled as the Impact Widget 

Dashboard.  At the right side there are two icons: 

 

This icon is used to order the widget windows which are on the desktop by name, in alpha 

ascending or descending order, and will tile the windows from the upper left corner of the Impact 

desktop. Widgets can be sized and positioned by the user, in typical Windows fashion. 

 

This icon is used to open the widget selection window.  Highlighting a widget name and clicking on 

it will either open or close the widget, depending on its current status. 

 

The three icons at the top right of each widget window are used to  Refresh the window content,     

Collapse or Expand the window and    Close the widget. 
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Report Schedules 

The ability to schedule reports was introduced with Impact/SQL version 8.0.  Scheduled reports will print 

in the background, freeing up the user to go on and perform other Impact functions.  Reports can be 

scheduled on a one-time basis or to print on a recurring basis.  The Impact Windows Service must be 

installed and functioning for report scheduling to function.  Scheduled reports can be tracked on the 

Report Schedules Widget.  If a report can be scheduled, you will see a Schedule button on the report’s 

option selection screen, like that shown here. 

 

 

If the Schedule button is present and you wish to schedule a report to run in the background, either once 

or on a recurring basis, first set your report options (unique by report type and discussed elsewhere in this 

manual) and then click on the Schedule button.  A screen like the ones shown here will be presented, on 

which you will manage scheduling options.  Two versions are shown below, one indicating the report is to 

run one time, and the other is preparing to schedule the report to run on a recurring basis. 

 This Impact Report Scheduler screen                                  This Impact Report Scheduler screen  

 reflects a One Time Schedule Type.                                    Reflects a Recurring Schedule Type. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system name of the report is reflected at the top of the screen (*.rpt), next to the Report File label.  

The name for the report, to appear on the Report Schedules Widget screen, is in the Schedule Name 

field, and the default value can be edited.  A Brief Description field is also available for an additional 

user comment.  
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The Schedule Type field is next, and can be set to One Time or Recurring.   

If Recurring is selected, the Interval Type can be set to Daily, Weekly or Monthly.   

If Daily is selected, the Days of Week entries, in the Timer Information section, are all checked and 

cannot be changed…the report will run seven days a week, at the time you set in the Timer Time field.   

Alternatively, select Weekly and check those days you wish the report to run (one or more) each week, 

and set the time.  Check all weekdays for Monday-Friday, for example.   

If you check Monthly, the Days of Week section of 

the screen will be replaced with one like that shown 

to the right that asks what day of the month to run 

the report. 

 

 

 

 

 

The Report Date Range section of the screen is used to select the date range of data to be included on 

the report, whether it is being run once or on a scheduled basis.  The options available are shown in the 

screen shot below (left).  Most are self-explanatory; the Custom Range option allows for running the 

report forward or back “x” number of days from the current date.  So, if you wanted the report to present 

the last 7 days of activity, each time it is run, you could do that, as shown below (right). 

 

 

 

 

 

 

 

 

 

The Report Schedules widget screen shown to the 

left reflects an Escrow Log Book report having been 

scheduled.  The report’s schedule can be modified, 

or deleted from this screen. 
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Standard Reports Menu 

The MIS module has two report paths: Standard and Custom.  The Standard Reports menu provides 

access to a set of three report sets which are common to all Impact databases.  The Custom Reports 

menu path allows the user to generate reports that are uniquely designed for the specific database.  It will 

be discussed later in this manual.  While some generic reporting is useful, most companies have their 

own preference for the kind of MIS they wish to use to managed their business decision making with.  

The discussion below will be about the standard MIS reports that all Impact databases come with. 

 

The Standard Reports menu will present the following three items: 

 Order Log 

 Order Counts 

 Income Analysis 

 

Order Log 

The Order Log report generates details of opened orders – either Escrow or Direct Order files – by 

branch.  The Order Log menu selection will present the user with the screen below, on which report 

options are selected.  

The user should enter a date range for file opening dates 

to be included in the report.  The date range is inclusive of 

the dates entered.  Then, the user should indicate if they 

wish to report on Escrow files or Direct Order files, by 

clicking on the appropriate check box.  Clicking on the OK 

button will generate the report. 

 

The report will present the Escrow or Direct Order #, the 

EO or TO Initials, Date Opened, Seller and Buyer Names, Property Address, Transaction Type 

code, Source of Business, Sales Price, Loan Amount and the Seller and Buyer Broker Names, if 

any.  A sample is shown below. 
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Order Counts 

The Order Count report generates detailed or summary reports of opened or closed escrow or direct 

order files, sorted by various parties.  The Order Count Reports screen, presented when the menu 

option is selected, is presented below. 

 

 

 

 

 

 

 

 

 

The user must select the date range for the data to be reported.  The  Calendar tool can be used to 

enter the dates, or the customary ddmm(yy) entry routine can be used. 

The user should select the desired option in the Report On section in the middle of the screen.  Those 

options are Escrows Opened, Escrows Closed, Escrow Summary, Directs Opened, Directs Closed 

and Direct Summary. 

After selecting the data to be reported on, the user should select the Sort by Report On option desired.  

The options are Marketing Rep (#1), Title Officer, Escrow Officer and Source of Business (Company 

Name). 

The Opened and Closed reports present file level detail (File Number, Branch Number, Date 

Opened/Closed, Marketing Rep, Transaction Type and Property Address), while the Summary 

reports present counts of Opened, Cancelled and Closed files, for the date range.  

Historically (in versions of Impact/SQL before 8.0) these reports presented estimated premiums (on 

Opened Escrow reports and all Direct Order reports) or HUD line 1108 premium figures.  With the 2010 

RESPA changes, the HUD line 1108 data is inappropriate and DSI felt it best to simply remove all 

“Premium” references from these standard reports.  The vast majority of Impact/SQL users have Custom 

MIS reports that present true Income data – from fee checks/slips and invoices – and, as most companies 

have unique income codes, there is no way to standardize that type of revenue reporting to a sub-set of 

revenue. 
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Income Analysis 

The Income Analysis option, on the Standard Reports menu, lets the user generate listings and 

graphical representations of income data, for a date range specified by the user, up through the Date 

Last Posted (and Year-to-Date, if a single branch is reported on).  The report is only of posted fee slip or 

fee check data.  Invoice data is not reported through this reporting option.  Simple bar and pie charts are 

generated in addition to the listing of results. 

The lncome Analysis screen, shown to the right, 

presents the options the user has with this reporting. 

First, they will identify whether a specific branch’s data is 

to be presented or an aggregate of all branches, via the 

Branch dropdown arrow. 

 If 000-All Branches is selected, the Income 

Code Options section will not be available for 

specific code selection.  Rather, the first two 

codes will be reported in aggregate by branch.  

The assumption is that the business has “Escrow 

Fees” listed first in their income code listing and 

“Title Premiums” listed second.  If this is not the 

case, the 000-All Branches option will produce 

invalid results. 

 If a specific branch is selected, the Income Code 

Options section will let the user check off which 

income codes to include in the report for the 

selected branch.  The reporting will be for the 

period identified and Year-to-Date. 

The Date Last Posted is presented, above the Date Range selection fields, as income data is only 

reportable up through the date of last posting.  Unposted income cannot be reported on.  The user must 

select the date range for the data to be reported.  The  Calendar tool can be used to enter the dates, 

or the customary ddmm(yy) entry routine can be used. 

Lastly, if 000-All Branches is the report Branch selection, there is a check box to Include Inactive 

Branches in the report – ensuring that all income data  will be reported on for the entire database. 

Clicking on OK, after setting the desired options, will present the Income Display screen, shown on the 

next page.  The sample is for one branch, so income codes are presented in the first column.  If 000-All 

Branches had been the selection, branch numbers and names would be presented in the first two 

columns and Escrow and Title revenue in the right-side columns. 
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The Income Display screen will present the data requested, on the List tab.  Also available are the Bar 

Chart and Pie Chart tabs. 

The date range requested is presented in the page titling.  If a specific branch’s data was requested, the 

Period Amount is presented, along with the Year To Date Amount, for each requested income code, for 

the requested Branch, and the branch will be identified in the titling.   

The  Print icon is used to send the displayed listing or chart to a printer.  

 

 

 

 

 

 

 

 

 

 

 

 

Use the  Close icon, in the upper right corner of the Income Display window, to return to the 

Income Analysis criteria selection screen.   
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Custom Reports Menu 

The Custom Reports menu is the path used to generate pre-designed custom MIS reports on demand, 

or to schedule them to be run routinely.  Depending on system configuration, reports may be able to be 

created or modified, with Crystal Reports ® , via an option on this menu.  Lastly, the Custom Reports 

menu is maintained from this menu (generally, this option is only used by the Crystal Reports ® team at 

USA Digital Solutions, when they add reports to a system). 

The Custom Reports menu will present the following four items: 

 Print Reports 

 Create & Edit Custom Reports 

 Custom Report Menu Maintenance 

 Statistics 

USA Digital Solutions should be contacted to design custom MIS reports to the Company’s specifications. 

Print Reports 

The Print Reports menu option will open the Custom Reports window, in which will be presented a 

“tree” of report menu categories, as shown below on the left.  To open any one category, the user should 

click on the boxed + sign in front of the category label.  In the second sample menu below, all categories 

have been opened, and a scroll bar has appeared, to let the user move through the menu.   

 

 

 

 

 

 

 

 

At the top of the window there is a Filter: field.  This filter 

is used to quickly narrow down the reports presented for 

selection, by the presence of the entry in the Filter: field 

in the name of the report.  Once three or more 

characters are entered into the Filter: field, the system 

will present all reports with that content in the reports’ 

names, as shown to the right, where “open” has been 

entered, to pull up all reports with “Open” in their title.  

The  Clear Filter icon is used to quickly delete the Filter: field contents. 
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Once the desired report title is located, double-clicking on it will trigger its running, and a window will be 

presented with one or two sections on it, depending on report configuration – Date Range and Custom 

Report Parameters.  The sample below reflects both.   

The Date Range section of the window, if presented, is used to enter the date range of the data to be 

included in the report.  The dates are inclusive.  The user will not be told the date field upon which this 

range will be applied – they will know this from familiarity with the report.  Most reports will detail, in their 

headings, what field was used for data selection if by date. 

 

 

 

 

 

 

 

The Custom Report Parameters section of the screen will only present if the specific report has 

parameters within it that can be selected by the user at run-time.  If presented, the parameters will vary by 

report.  The  Info icon next to each parameter will provide guidance to the user.  The user should make 

the desired selection for each parameter presented before clicking on OK to generate the report. 

The Schedule button will be enabled if the Impact Windows Service is installed and running.  Please see 

the Report Schedules section earlier in this manual for information on scheduling reports. 

Once OK is clicked on, to generate the report, the user will be presented with the standard Print control 

screen from which the report can be printed, previewed, emailed or published (if so configured). 
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Create & Edit Custom Reports 

The MIS reports (and other reports in Impact’s other modules) are based on Crystal Reports ® templates.  

Prior to version 8.0 of Impact/SQL, Crystal Reports 8.5 ® was used to develop reports.  With Impact/SQL 

version 8.0, Crystal Reports 2008 ® was introduced.  Once a company ceases to use versions of Impact 

below 8.0, they can use Crystal Reports 2008 ® to prepare custom MIS report templates for use in the 

MIS module.   

Most companies rely upon USA Digital Solutions, Inc.’s Crystal Reports ® team to prepare their custom 

MIS report templates, as they have the data structure knowledge, as well as Crystal Reports ® 

experience, to prepare reports quickly and accurately.   

If the company wishes to create and edit their own custom MIS reports, to be run from the Custom 

Reports menu, they will need either Crystal Reports 8.5 ® or Crystal Reports 2008 ® installed.  Impact, 

via the XREF settings in the Utilities module, can be configured to identify where the CRW program files 

are installed, and will look to that location if this option is selected.  If it finds the appropriate files, it will 

open up the Crystal Reports ® editor.  If the program files are not located, a message to that effect will be 

presented. 

USA Digital Solutions, Inc.’s Crystal Reports ® team should be consulted for data structure questions. 

The use of the Crystal Reports ® editor is beyond the scope of this manual.  
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Custom Report Menu Maintenance 

This menu option is used to modify the MIS Custom Reports Menu.  Normally, DSI Crystal Reports ® 

team members will be the ones to use this function, but MIS users can use it to add or delete items from 

the menu or re-arrange the menu.  Care should be taken when working with this function – and it is 

always a good idea to print out the existing menu, before making changes.  The editing of the menu is 

done in conjunction with the physical placement or removal of the actual report template(s) in their 

location on the Company’s systems – that is not done by the menu maintenance function. 

 

 

 

 

 

 

 

A “tree” is presented of the existing report headings, with the addition of an Uncategorized heading, and 

function icons across the top of the screen are used to edit the menu and print out the current menu, as 

described below. 

 Print – this icon will generate a report of the current menu, detailing the contents of the menu. 

 New Heading – this icon is used to create a new report category heading.  The user should highlight 

the heading above the point where the new heading should be inserted, and click on the Add Heading 

icon.  A screen will be presented through which the new heading is entered. 

 New Report – this icon is used to create a new report menu entry.  If the user has a report category 

highlighted when this icon is clicked, the new report entry will be added at the end of the categories listing 

of reports.  If a specific report, within a category is highlighted when this icon is clicked, the new report 

entry will be added below the highlighted report.  The report template DOS name will be required (and the 

report template must be in place already for the menu entry to be accepted by the system) and a long 

name, for the menu, is called for.  If a Date Range is required when running the report, the checkbox to 

call that option is to be checked. 

Once a heading or report exists, double-clicking on the entry will open a window that provides for editing 

the entry. 

 Delete – this icon will remove the highlighted entry from the menu. 

 &  Move Up and Move Down – these icons will move the highlighted entry up or down the menu 

tree.  These icons can be used to move a report entry to another category or just within one.  They can 

also be used to move category headings.  Note: moving a heading does NOT move the contents of the 

category. 

Click on the OK button, at the bottom of the screen, to save changes made to the Custom Report Menu, 

or Cancel to exit without saving changes. 
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Statistics 

The MIS Custom Report Statistics report will present the custom MIS report menu and indicate the 

number of times (since the upgrade to version 10.3) each report has been run, the first and last dates 

each was run, and by whom.  This will aid in the effort to determine which custom reports are actively 

used and should be maintained when changes to underlying report criteria (income code groupings, for 

example) are made.  It is run with the Statistics option on the Custom Reports menu. 
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Setup 

The Setup menu entry is used to add or remove fields from the Marketing_Escrow or Marketing_Direct 

tables.  These tables are used to aid in generating MIS reports by placing values in a single-record-per-

file table, when the source data might be routinely stored elsewhere in the SQL database – in a difficult 

location for reporting from.  Obviously, one table is related to Escrow files and the other to Direct Orders.  

There is a limit to how many fields can be added, but it is a function of the size and type of the fields, so a 

specific number cannot be stated. 

Below the Setup menu entry is one option – Add/Remove Database Fields – below which are two 

choices: Escrow and Direct.  Both entry/edit routines are common in behavior and so only one will be 

described below. 

 

 

 

 

 

 

 

 

 

Once the Escrow or Direct sub-menu option is selected, a screen like that above will be presented.  On 

the left side of the screen are available fields that have not been added to the Marketing_Escrow (or 

Marketing_Direct) table, and on the right are fields that are already in the table and available for use in 

custom MIS reports. 

Highlighting a field on the left side of the screen and clicking on the Add >> button, in the middle of the 

screen, will cause that field to be added to the listing on the right side – but the actual addition of the field 

and the data to fill it, from each file, will occur after the OK button is clicked.  Multiple fields can be added 

at a time, but, depending on the size of the database, the adding of fields can be a lengthy process.  

Again, as stated above, there is a limit to how many fields can be added, but it is a function of the size 

and type of the fields, so a specific number cannot be stated.  

The Filter: field, at the top of the screen, can help the user locate a field to be added to the table.  

Entering three or more characters in the Filter: field will trigger a search for that character string 

anywhere in the field name listing on the left side of the screen – not just entries that start with that 

character string.  The  Clear Filter icon is used to remove any entry in the Filter: field. 

The << Remove button is used, after highlighting a field on the right-hand list, to remove a field from the 

Marketing_Escrow table.  This should only be done if the user is absolutely sure the field is not being 

used in any custom MIS reporting. 

The Cancel button will let the user exit the screen without effecting any requested change. 

The OK button will cause the screen to close and any add or remove actions requested will be 

processed, and the user will see a screen explaining what is being done.  
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Tools 

The Event Log can be seen from the Tools menu.  Other tools may be added in the future. 

 

Event Log 

When Event Log is selected from the Tools menu, the Event Log – Impact MIS Module screen will be 

displayed, as shown below (no entries are shown on this sample screen). 

 

 

 

 

The Event Log presents a listing of errors that have been captured by Impact/SQL when a problem 

occurs.   The Event Log, in each module, replaces the SQL Error Log that versions of Impact/SQL prior 

to v8.0 utilized, and will capture more information 

than that log did. 

Double-clicking on an entry will present more 

information on the error, on an Event Details 

screen, like that shown to the right. 

The &  arrows, if activated, will move the 

user up or down the error listing.  This is helpful 

when reviewing a string of related items. 

The  Copy icon is used to copy the contents of 

the Event Details to the user’s clipboard, from 

which the information can be pasted into an email 

or MS Word document for transmission to DSI for 

troubleshooting, for example.   

Click OK to close the Event Details screen. 

 

The  Refresh icon, at the top of the Event Log screen, is used to re-query the event table and re-

present the listing of events. 
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The  Edit Filter icon, also at the top of the Event Log screen, will present a screen of options that can 

be used to filter the events to narrow the list presented to those most likely to be the ones the user wishes 

to study. 

 

 

 

 

 

 

 

 

Start Date and End Date fields can be utilized to filter data, as can the Category and User Name fields.  

The Description Contains: field is used to search the event descriptions for the text entered.   

The Computer Name: field can be used to limit the events presented, to narrow the focus. 

Click on OK to execute the filter as defined, or Cancel to exit.  Reset will clear the filter to the defaults. 

If a filter is in place, the  Remove Filter icon will be enabled, at the top of the Event Log screen, and is 

used to return the Event Log to the default state of presenting all events. 

Clicking on the Date column header, on the Event Log screen, will sort the events listed in ascending or 

descending order (alternates with each click), and an  arrow indicating the direction of the sort will present 

next to the Date label. 
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About Menu 

To determine the Impact MIS module version and build number, select the About menu option.  Please 

have this version number information available when calling the Help Desk for assistance. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: The build number for each Impact/SQL module, shown after the version number, may be different 

from another Impact/SQL module, for example, the Escrow module may not be the same build as the MIS 

Module. 

 

  

 Version and Build 
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Appendix A - Troubleshooting 

USA Digital Solutions, Inc. (DSI) Support personnel may ask that you make a screen shot so that you can 

e-mail Support a “picture” of the screen as it appears when the error occurs. 

To create this screen shot, save it and send it to the Support personnel, do the following: 

Press the PRINT SCREEN key on the keyboard, which is usually located on the top row of the keyboard, 

and is usually the third key from the right. 

Open your e-mail client, start a new e-mail, to Support@Digisolaz.com, and Paste the screen shot into 

the body of the e-mail.  This will work if the e-mail format is HTML.  If the screen shot does NOT paste 

properly, open a Word document and paste the screen shot into it; save the Word doc; and, attach it to an 

email addressed to Support@Digisolaz.com. 

DSI Support personnel can be reached at (602) 866-8199 extension 2. 
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